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EXECUTIVE SUMMARY
The main purpose of this test was to asses the performance of an actual customer with
little or no previous InTouch experience. The usability test measured the total time
needed to accomplish information entry and output, and record user critical incidents.
Tasks included routine operations, print operations, and import/export of data.

Each test session consisted of a performance test where the user performed a series of
tasks, and a post-test interview where the user filled out a brief user preference
questionnaire about the functionality and usability of InTouch and was given the
opportunity to make comments or ask questions about InTouch.

Evaluation measures included: observations and comments for each critical incident;
classification of errors associated with critical incidents including severity, scope, and
source of error; the time necessary to complete each task; the percentage of
participants who successfully complete each task; and user rankings of the functionality
and usability of InTouch.

All participants did fulfill InTouch developer goals of having users succeed in entering
information into InTouch within the first 5-10 minutes of use and outputting information
from InTouch within the first half hour of use. Although, many participants did have
major problems.

User likes included the InTouch documentation, the exclusion option in sort, the option
of creating a new group from the group search dialog box, the choice of sounds for
reminders, and the repeat option for reminders.

User dislikes included having to search the giant InTouch menu, the difficulty figuring
out the function of the different panes in the main window, the lack of on-line help, and
the lack of access to group functions from the main window. Users also disliked
InTouch not behaving like other Macintosh applications: its files could not be opened by
double-clicking, and no one liked having to select InTouch from the menu to start-up
the program. Most users also had problems with the print and layout dialog boxes.

Problems were rated in terms of severity and scope, and whenever possible, the source
of the problems and potential solutions were indicated. The solutions presented in this
report are just recommendations. Re-design efforts should consider alternative
solutions with both the problems and potential solutions evaluated in light of the total
system.
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TEST DESCRIPTION
The main purpose of this test is to asses the performance of an actual customer with
little or no previous InTouch experience. The usability test measured the total time
needed to accomplish information entry and output, and record observed critical
incidents. Tasks included routine operations, print operations, and import/export of
data.1 Particular attention was paid to those features that have been the target of
significant negative customer feedback.

Specifically, the test attempted to determine if an actual user with little or no previous
InTouch experience can

 Successfully enter information into InTouch within the first 5-10 minutes of use.2

 Successfully output information from InTouch within the first half hour of use. 3

 Successfully perform routine tasks associated with sorting, grouping, and retrieving
of information.

 Successfully use print and import / output dialogs.

The Prairie Group has received complaints about the printing and import / export
dialogs. The test will attempt to determine the precise nature (and possibly the source)
of customer difficulties.

Procedure
Test sessions had three stages:

1. General Introduction where the participant was given a short introduction to the
testing and introduced to the testing environment. The subject was also given a
short demo of thinking aloud.

2. Performance Test which consisted of a series of tasks that the participants were be
asked to perform. Participants were videotaped while performing tasks.

3. Post-test debriefing in which the participant filled out a brief user preference
questionnaire about the functionality and usability of InTouch, and was given the
opportunity to ask questions or make comments about InTouch and the testing
process.

Evaluation Measures
The following evaluation measures were collected and calculated.

1. Observations and comments for each critical incident.

2. Classification of errors associated with critical incidents: severity, scope, and source
of error were indicated whenever possible.

3. The time necessary to complete each benchmark task.

1 Originally, installation was included in the task list. However, as the installation process is straightforward
but time-consuming, it was not included in the final task list.

2 5-10 minutes is Prairie Group development goal.
3 First half hour is Prairie Group development goal.
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4. The percentage of participants who successfully completed each task.4

5. Participant rankings of the functionality and usability of InTouch.

4 A task is classified as successful or unsuccessful. No partial measures of completion will be used.
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RESULTS
This section contains a summary of the usability test results in tabular form. It includes
summaries of both the performance test and questionnaire results. The performance
test results include for each task: mean positive/ negative critical incident counts5,
percentage of users who successfully completed the task, and mean time to complete
task. The post-test questionnaire results are the mean user satisfaction scores from the
post-test questionnaire.

Performance Test Summary

Task
Mean Number

Positive Critical
Incidents

Mean Number
Negative Critical

Incidents

% Subjects That
Successfully

Completed Task

Mean
Time
(sec)

Insert a Record 0 1.6 100 160.8
Save a File Under a
Different Name

0 2.8 100 123.8

Find a Specific Record 0.2 3 60 220.6
Delete Records
Belonging to a Group

0 2.4 80 134.2

Sort a File 0 1.2 100 234.2
Add a Reminder 0 5 100 421.8
Make a New Group 0.2 3.4 60 346.4
Print a Fax Cover 0 3.8 80 362.4
Export Records
Belonging to a Group

0 1.4 60 203.6

Find Records Using a
Simple Group Search

0 1.8 60 186

Find Records Using a
Complex Group
Search

0 1.4 80 75.8

Import Data From a
File

0.6 2.8 60 338.6

Close then ReOpen
InTouch

0 1.2 60 54.8

In any re-design efforts, particular attention should be paid to improving those tasks with
a less than 80% completion rate.

5 Critical incidents are something that happens while participant is working that has significant effect, either
positive or negative, on task performance or user satisfaction. (Hartson, 1993)



7

Post-Test Questionnaire Summary

Mean Rating
6

Overall Reactions to InTouch 4.4

terrible ... wonderful 4.4

difficult ... easy 3.8

dull ... stimulating 3.4

inadequate power ... adequate power 5.8

rigid ... flexible 4.6

Screen 4.4

Organization of information on screen 3

Sequence of screens 4.2

Characters on computer screen 6.2

Highlighting on screen simplifies task 4.2

Terminology and System Information 3.76

Use of terms throughout system 4.4

Computer terminology is related to the task 4.2

Messages on screen which prompt user for input 3.2

Computer keeps you informed about what it is doing 4.2

Error messages 2.8

Learning 3.6

Learning to operate the system 2.8

Exploring new features by trial and error 4.8

Tasks can be performed in a straight-forward manner 3.2

Remembering names and use of commands 3.4

Help messages on the screen 2.6

Supplemental reference materials 4.6

System Capabilities 3.75

Correcting your mistakes 5.4

Experienced and inexperienced users’ needs are taken into
consideration

2.8

As a free-form information manager, InTouch is 4.4

When compared to other information managers you have
used, InTouch is

2.4

6 The post-test questionnaire rating scale went from 0 to 9.
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FINDINGS, EXPLANATIONS, AND RECOMMENDATIONS
This section contains the findings and recommendations, along with a brief discussion
and explanation of them. It has been divided into General Findings and
Recommendations followed by Specific Findings and Recommendations.

The General Findings and Recommendations section contains a high-level discussion of
the major, global issues.

The Specific Findings and Recommendations contains tabular lists of user likes, user
wish lists, and user problems.

Finally, the solutions presented in this report are just recommendations. Any re-design
should consider alternative solutions. Both the problems and potential solutions should
be evaluated in light of the total system.

General Findings and Recommendations
Happily, all participants did fulfill InTouch developer goals of having users succeed in
entering information into InTouch within the first 5-10 minutes of use and outputting
information from InTouch within the first half hour of use. Unhappily, many encountered
major problems: they had great difficulty figuring out the function of the different panes
in the main window and they floundered about in the giant InTouch menu. Many
grumbled about the lack of access to group functions from the main window and were
frustrated by the lack of on-line help.

Probably what frustrated people the most was the giant InTouch menu. It was too big to
search quickly or accurately. Further, it contained items generally found in the File or
Edit menus, e.g. SaveAs, so it was usually the last place users looked. This menu
should be broken up into a series of smaller menus. The File menu should contain file
commands, the Edit menu should contain editing commands. The remaining
commands may be parceled out to one, or more, menus. Users can be recruited to sort
the commands into groups to help develop a menu grouping that is more intuitive to
users.

Participants also had a great deal of trouble determining the functions of the different
panes and buttons in the main window. Labeling of the windows and better button
labels should alleviate many of the problems as would on-line help. In tests, users
infrequently referred to the documentation, but frequently went to look for on-line help.

Participants were also disliked InTouch not behaving like other Macintosh applications.
Its files could not be opened by double-clicking. Its files do not appear under “Recent
Documents” in the menu, nor did InTouch appear under “Recent Applications” in the
menu. No one liked having to select InTouch from the menu to start-up the program.

The print and layout dialog boxes were another problem area with users. Most found
the boxes too cluttered and the icons indecipherable. Both would benefit from a visual
re-design and extensive usability testing focusing just on them.
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Specific Findings and Recommendations

Good Points

Documentation

Users gave InTouch documentation high marks. Unfortunately users seldom referred to
it, even when having problems.

Sort

Users also liked the sort exclusion option.

Find

Users liked that find isn’t necessarily case sensitive.

Group Search

Users found the option of creating a new group when in the group search dialog box
very handy.

Reminders

Users especially liked the sound and repeat options.

Problems

This section contains a tabular listing of the specific problems uncovered along with
potential solutions. It is organized in terms of existing interface elements.

Problems are classified in terms of Keenan’s usability taxonomy (Keenan, 1996). They
are also assigned an importance rating. Importance is a subjective measure of the
problems effect on usability and is independent of cost. It is determined as follows:

Importance
Rating

Description

Low
If problem did not impact task performance or dissatisfaction very much (e.g.,
irritant or cosmetic problem), but is still worth listing.

Medium
If user can complete task, but ability to perform it properly was seriously
hampered (e.g., caused confusion and required extra effort), or problem was
source of dissatisfaction.

High
If interface feature involved is mission critical or is a major source of explicitly
expressed dissatisfaction, or if usability problem is a "show stopper" (e.g., user
cannot complete key task).

Close / Quit InTouch
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Problem Error Classification /
Discussion

Importance Potential
Solution

When prompted to save
changes, user cannot
cancel operation.

Missing physical
affordance (32.11).

Missing button (20.2)

Low Activate cancel button in
save dialog box.
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Documentation

Problem Error Classification /
Discussion

Importance Potential
Solution

No on-line help. Functionality: missing
functionality that the
users want (35.1).
Users seldom referred to
written documentation,
but often requested on-
line documentation.

Medium Add on-line help to system.

User would like to know
which index entry is the
primary reference for a
topic.

Important information
not emphasized (21.5)

Low Bold primary page in index.

Balloon help is not
available.

Missing user-requested
information (52.1).

System did not help user
start or complete task.
(39.6)

Low Add balloon help to
application.

File Operations

New

Problem Error Classification /
Discussion

Importance Potential
Solution

User has trouble finding
new file command
(“New”) in the menubar.

Menu organization:
inappropriately grouping
unrelated choices in a
menu (19.9). By
convention, new file
command is usually
found in the File menu.

Metaphor doesn’t make
sense to user (32.4).
User does not
understand why all
InTouch items are in the
InTouch menu.

High Move “New” to a location
more intuitive to Mac users,
i.e. the File menu.
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User has trouble
understanding the
function of the “New...”
command in the InTouch
Menu

Names / labels: wording
not meaningful enough
(24.7)

High Place option in File menu
which will provide a context
for user understanding
(preferred); or rename
option to “New File...”.

User confused by “Save”
button in “New” dialog
box.

Names/Labels: system
centered terms instead
of user, task domain
terms (24.4). User is
creating file; system is
saving an empty
InTouch file.

Low Change label to “Create”.

Open

Problem Error Classification /
Discussion

Importance Potential
Solution

User has trouble finding
open file command
(“Open”) in the menubar.

Menu organization:
inappropriately grouping
unrelated choices in a
menu (19.9).

Metaphor doesn’t make
sense to user (32.4).
User does not
understand why all
InTouch items are in the
InTouch menu.

High Move “Open...” to a location
more intuitive to Mac users,
i.e. the File menu.

Buttons in “Open” dialog
box are ordered differently
than buttons in other file-
related dialog boxes, e.g.
“Save As” dialog box.

Inconsistent screen
layout (19.1). In “Open”
dialog box, buttons are
ordered “Open” to
“Cancel”, while in other
file-related dialog boxes
buttons are ordered from
“Cancel” to box action,
e.g. “Save”.

Similar tasks are
structured inconsistently
(32.1).

Low Order the buttons in the
“Open” dialog box in the
same manner as the other
dialog boxes.
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Recent Files

Problem Error Classification /
Discussion

Importance Potential
Solution

User has trouble finding
files that were recently
opened by InTouch.

Menu organization:
inappropriately grouping
unrelated choices in a
menu (19.9).

Metaphor doesn’t make
sense to user (32.4).
User does not
understand why all
InTouch items are in the
InTouch menu.

Medium Move “Recent Files” to a
location more intuitive to
Mac users, i.e. the File
menu. Preferably include
list of recent files at the end
of the menu before quit;
separate with a bar from
standard items and quit
option.

No directory information
for files is given. If two
files with same name
were recently used, user
has no way to distinguish.

Name not meaningful
enough (24.7).

Medium Add directory information.

InTouch data files do not
appear under “Recent
Documents” in the
menu.

Missing shortcut (34.4). Low Ensure InTouch data files
appear as recent
documents.
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Save

Problem Error Classification /
Discussion

Importance Potential
Solution

User has trouble finding
save file command
(“Save”) in the menubar.

Menu organization:
inappropriately grouping
unrelated choices in a
menu (19.9).

Metaphor doesn’t make
sense to user (32.4).
User does not
understand why all
InTouch items are in the
InTouch menu.

High Move “Save” to a location
more intuitive to Mac users,
i.e. the File menu.

User confused when
asked if wishes to save
changes in a file that has
not been changed.

Cause: if “Confirm Save”
preference is not selected
and user changes data
files without saving
changes, the user will be
prompted to save
changes when performing
a sort on a newly opened
file.

Misleading feedback
message (26.13).

Temporal problem ...
how to handle.

Medium Message should only
consider current file.
Internal flags should be
reset when the next file is
opened.

Save As

Problem Error Classification /
Discussion

Importance Potential
Solution

User has trouble finding
save as file command in
the menubar.

Menu organization:
inappropriately grouping
unrelated choices in a
menu (19.9).

Metaphor doesn’t make
sense to user (32.4).

High Move “Save As...” to a
location more intuitive to
Mac users, i.e. the File
menu.



15

Group Operations

Problem Error Classification /
Discussion

Importance Potential
Solution

User cannot access group
functions from main
window.

Missing physical
affordance to access
functionality from main
window. (32.11)

High Add group button on main
window. Re-evaluate
button usage on main
window; eliminate the
infrequently used to cut
down on clutter in main
window.

User tries to view group
by double-clicking on
group’s name in group
window. Extremely
common novice error.

Missing direct
manipulation (29.2)

Mental model not easy
to understand (32.5)

Medium Label the window, e.g.
record’s group
membership.

User doesn’t notice
checks result from
double-clicking on group
name. Fairly common
mistake.

Check mark signaling
group membership is not
noticeable (20.6).

Interface modes not well
distinguished (39.9)

Medium Use a different symbol.
Consider highlighting
groups to which the current
record belongs.

Group Edit

Problem Error Classification /
Discussion

Importance Potential
Solution

User doesn’t connect
“Edit Groups ...” with
creating a new group.
Thinks that it will allow her
to specify which records
belong in a group.

Label not meaningful
enough (24.7)

Medium Try to find a better label,
e.g. add/delete groups.

User is confused by
“Delete...” and “Insert...”
buttons not working on
groups.

Inconsistent ways to
manipulate similar
objects (29.1)

Similar tasks structured
inconsistently. (32.1)

Medium 1. Allow user to delete
group shown in “Groups
List” by highlighting group
names and hitting
“Delete...” button; or.

2. Change label on button
to “Delete Record”.
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User wants to be able to
edit group names in
“Groups List”

Inconsistent ways to
manipulate similar
objects (29.1)

Similar tasks structured
inconsistently. (32.1)

Medium Allow user to directly edit
group names in “Groups
List”.

User can move or delete
individual groups, but can
not move or delete the
groups in a single step.

User task not mapped to
the system even though
functionality to support
task is present (32.9).

Cognitively indirect
manner to manipulate
groups (29.8)

Medium Allow user to highlight
several groups and
manipulate those groups,
e.g. delete.

User has to alphabetize
list by moving groups --
cannot alphabetize list in
one step.

Interaction: user task not
mapped to the system
even though functionality
to support task is
present (32.9).

Cognitively indirect
manner to alphabetize
groups (29.8)

Medium Option on Group Edit dialog
box to alphabetize (or sort)
list; explore possibility of
keeping the “Temporary”
and “Marked” groups in
same position, and
alphabetizing rest of list.

User would like a pre-
defined shortcut for “Edit
Group”.

Missing shortcut (34.4). Low Add a default shortcut for
“Edit Group”.
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Group Search

Problem Error Classification /
Discussion

Importance Potential
Solution

User believes group
search returns all records
and group names
matching the input
specification.

Misleading label (24.9);
label indicates searches
for groups.

Medium It’s just a special type of
find. Change label to reflect
that.

Consider combining find
and group search into
single function with group
search functions handled as
options of the basic find,
much in the same manner
as find file does on the Mac.

User destroys records
belonging to a group with
group search.

The way results are
formatted is not
noticeable (20.7)

No confirmation for
actions with
consequences (39.2)

Medium If attempt to overwrite any
group other than temporary
and marked, ask for
confirmation first.

User not sure requested
group search operation
was done.

Presentation is not
noticeable.

System does not guide
user’s attention to the
relevant part of the
screen to notice results
(39.7)

Medium Make search results more
noticeable; try presenting in
a separate window.

User dislikes having to
always go through “Find”
or to the menubar to get
to “Group Search”.

Extra steps in task on
system (32.7)

Medium Consider eliminating group
search as a separate
operation, and make extra
capabilities find options.
Something along the lines
of find file on the
Macintosh.

“Group Search” dialog
box does not contain a
cancel button.

Direct Manipulation:
missing direct
manipulation (29.2).
User close dialog box or
hit “Done” (and thereby
canceling request) but
cannot directly cancel
request.

Low Add “Cancel” button to
“Group Search” dialog box.

User wants to be search
more than one group at a
single time.

User task not mapped to
system even though
functionality to support is
present (32.9)

Low Modify dialog so that user
can select more than one
group to search.
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Import / Export

Problem Error Classification /
Discussion

Importance Potential
Solution

User wants to highlight a
range of records and
export them.

Functionality: missing
functionality (35.1).

Medium Add capability.

Not clear what group
imported records are
placed in.

Placed in current group
by default. Specification
not an explicit part of the
dialog. User must
remember to create /
change group before
beginning import.

Interaction too complex
(32.3)

Missing object (20.2)

Medium Specify the group as part of
the import process. Make
current group default.

User wants to be export
more than one group at a
single time.

User task not mapped to
system even though
functionality to support is
present (32.9)

Low Modify dialog so that user
can select items belonging
to both groups to export.

Installation

Problem Error Classification /
Discussion

Importance Potential
Solution

2 icons with install in their
name on the installation
disk; user does not know
which to use and in what
order.

Language problem;
multiple dissimilar
objects named too
similarly. Clear in
documentation but most
people don’t read
documentation.

Task-Facilitation
problem: system did not
guide or direct user's
attention to help the user
start the task.

Low Rename icon(s), or
combine functionality.
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Main Window

Problem Error Classification /
Discussion

Importance Potential
Solution

Novice InTouch user has
great difficulty discerning
function of the different
panes.

Missing label (24.2), and
user did not understand
interaction (32.3).

During usability testing,
some users never fully
understand the functions
of the different panes,
even after using the
product for an hour or
more. Concept very
difficult to uncover by
trial and error, and most
users did not refer to the
paper manual --
although most did look
for on-line
documentation.

High Panes should be labeled to
facilitate learning process.

On-line help and bubble
help should be available to
increase the likelihood of
users accessing
documentation.

User has no idea why
“Tag” would be used.
Clicks it several times,
guesses that character
might be footnote, and
finally deletes characters.

Tag not meaningful
enough, users frequently
do not understand what
action is associated with
the button (24.7).

Also, interaction: user
did not understand
interaction (32.3).

High - More descriptive label, but
may be difficult due to
combined functionality, may
want to break up.

- Real question about
whether this belongs on
main window. Consider
placing in a menu so can
list symbol, what it does,
and shortcut.

User must click on
“Stamp” to figure out what
button does.

Stamp not meaningful
enough, users frequently
do not understand what
action is associated with
the button (24.7).

Medium Does this belong on the
main window?

- If it does, use a better
label, e.g. date/time stamp.

-If it doesn’t, place it in a
menu and provide a
shortcut.
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User not sure how Group
pop-up controls record
display.

User did not understand
the interaction (32.3)

Label does not indicate
full effect of action (24.8)

Medium Add a more descriptive
label to pop-up, e.g. Display
Group.

User not sure what the
arrows apply to.

Arrows apply to records
but are over by address
field.

That work together
(records list and arrows)
are not close enough to
each other (19.11)

Medium Can they be incorporated
into scrolling device.

When group list and
record list was
compressed, user thought
record, group
placeholders were labels
for the address/notes
field.

Dissimilar objects look
too similar, i.e.
horizontally compressed
panes look like labels.
(20.12)

Low Add (Pull Out) to
placeholder label for a
horizontally compressed
field.

Menubar

Problem Error Classification /
Discussion

Importance Potential
Solution

User has trouble finding
options in menubar
menus.

Menu organization:
inappropriately grouping
unrelated choices in a
menu (19.9).

Having all InTouch
operations accessible
from one giant InTouch
menu confused users.
Also, it increased search
time and increased the
probability that a user
would miss the option
being searched for.

High InTouch menu should be
broken into a smaller
menus consisting of related
choices, e.g. place all file
operations in the File menu.

Novice InTouch user
doesn’t realize the
menubar contains
InTouch options when the
main window and
menubar do not abut.

Screen layout: objects
that work together are
not close enough to
each other (19.11).

When the menubar and
main window did not
abut, novices assumed
InTouch consisted only
of the main window.

High At startup, the InTouch
main window should abut
the menubar.
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“Quit” appears in both the
Files and InTouch menus.

User did not understand
the presence of
duplicate quits (32.10).

Low Remove Quit from InTouch
menu.

Open InTouch

Problem Error Classification /
Discussion

Importance Potential
Solution

User confused by lack of
InTouch under “Recent
Applications” in the
menu.

Missing shortcut (34.4).
By Mac convention,
InTouch should be there.

High Ensure InTouch appears
under recent applications.

User cannot open
InTouch file by double-
clicking on an InTouch
data file.

Missing direct
manipulation (29.2).
Also, missing shortcut
(34.4).

By Mac conventions,
users expect to be able
to double-click on any
file. Even experienced
InTouch users invariably
try to open a file by
double-clicking. Not one
user went to the menu.

High Allow user to open InTouch
files by double-clicking.
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Preferences

Problem Error Classification /
Discussion

Importance Potential
Solution

User unable to specify
which data file to be
opened at start up.

Task not well mapped (
32.6). User never
discovered that start-up
file could be specified in
the “Open...” dialog box.
User thought of it as a
preference, not an open
operation.

High Allow the user to specify the
startup file as a preference
and when opening a file (a
few experienced users
found this handy).

User does not understand
that “Confirm Saves” in
the General Preferences
dialog box will result in the
user being prompted to
save changes when
closing InTouch or
switching data files.

Names / Labels: label is
misleading (24.9);
“Confirms Saves”
implies that system asks
for confirmation after a
save has been initiated.

Medium Re-word dialog, e.g. prompt
to save changes.

User cannot specify that
InTouch open the last
data file used at startup.

System does not allow
user to specify his/her
preferences in this area
(34.1), i.e. user can
specify which file to open
at startup, but user
cannot specify InTouch
use the last file opened.

Low Add a preferences option
that tells InTouch to open
the last file opened at
startup.
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Printing

Layout Dialog

Problem Error Classification /
Discussion

Importance Potential
Solution

Users have great difficulty
using layout dialog box;
some users refuse to
even try.

Numerous visual layout
problems: inconsistent
screen layout (19.1),
screen clutter (19.2), too
many objects on screen
(19.2), unaesthetic
layout of objects (19.3),
not clearly delineating
groups of objects with
borders, boxes, or
spacing (19.13), object
grouping not intuitive to
user so user could not
use grouping to help
locate an item.

Also, interaction is
simply too complex
(32.3)

High Redesign from scratch.
Look and feel should be
more like Print dialog box.
Instead of making
everything visible, put the
less frequently used groups
down a level or in a pull
down menu. Also, try
halving the size of the
graphic representation of
the layout to allow more
space for the functionality.
Design should be iterative
and involve substantial user
testing.

User doesn’t recognize
item icons in “Layout”
dialog box.

Object Appearance: icon
is not meaningful
enough (20.9). Icons
are too small and busy
to be easily recognized.

High Simplify icons to facilitate
understanding and add
labels.

User can’t determine what
units are used for the
layout width/height.

Object layout: objects
that work together, i.e.
width/height and units,
are not close enough
together (19.11).

High Move the units and
dimensions closer together.
May want to use borders or
boxes to emphasize
connection.

User complains of objects
jumping around as he
explores the different
layouts.

Inconsistent object
layout (19.1)

Also, system did not
guide or direct user’s
attention to the relevant
part of the screen (39.6).

High Common functionality exists
across different layouts,
however implementation
details vary. Group and
label by common
functionality.

When creating fax cover,
user doesn’t want to have
to specify record. Would
like the default to be
current record.

Missing default value
(36.3).

Medium Make current record
default.
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“Layout” dialog box does
not contain a cancel
button.

Missing direct
manipulation (29.2).
User closes dialog box
or hits “Done” button
(and thereby canceling
request) but cannot
directly cancel request.

Low Add “Cancel” button to
“Layout” dialog box.

Print Dialog

Problem Error Classification /
Discussion

Importance Potential
Solution

User doesn’t recognize
item icons in “Print” dialog
box.

Icons are too small and
busy to be easily
recognized. (20.4)

High Simplify icons to facilitate
understanding and add
labels.

User attempts to use the
“Layout” pulldown in the
“Print” dialog box to select
the item to be printed.

Screen Layout: object is
not placed for best effect
(19.16)

Also, task-
mapping/interaction:
task not mapped well,
mapping does not reflect
the structure of the
user’s task (32.6). User
wants to specify the item
to print before specifying
the layout.

Medium Place “Layout” pulldown
beneath mechanism to
select item to be printed.
May want to re-label. Users
frequently referred to layout
as format.

Too many options on
print/print dialog box. User
spending a lot of time
worrying about things she
doesn't need to.

Too many objects on
screen (19.2)

Interaction is too
complex (32.2)

Low Differentiate between the
necessary and secondary
options. Consider placing
secondary options at a
lower level.
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Record Operations

Delete

Problem Error Classification /
Discussion

Importance Potential
Solution

User cannot undo record
delete.

User Action Reversal:
user unable to undo an
action (37.1).

High “Undo” action should apply
to InTouch record
operations. Recommend
that all “Edit” actions be
made functional for records.

User inadvertently deletes
a record. Had highlighted
a portion of the record
and hit the delete button;
assumed delete would
only apply to portion
highlighted.

Names/Labels Problem:
24.7; wording not
meaningful enough.

High Change label to “Delete
Record”.

In the delete confirmation
message, user assumes
item refers to the portion
of record highlighted, not
the entire record.

Feedback Message
Problem: 26.5; feedback
message vague -- not
clear what item refers to.

High Change item to entire
record.

User must delete
individual records to
delete a group of records.

Interaction: user task not
mapped to the system
even though functionality
to support task is
present (32.9), i.e. user
can delete individual
records but cannot
delete multiple records in
a single step.

Medium Allow user to highlight
several records in “Records
List” and delete them.

“Delete...” on record
delete button indicates a
dialog box should pop up,
but dialog box only pops
up when “Confirms
Delete” option is active.

Names/Labels:
misleading name/label
(24.9).

Low Remove ... from label.
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Edit

Problem Error Classification /
Discussion

Importance Potential
Solution

User can easily find all
instances of a given
string, but cannot easily
replace instances of the
string.

Functionality missing
(35.1).

High Modify find dialog to include
replace and replace all
operations.

User would like to spell
check information.

Functionality: missing
functionality (35.1).

Useful if you are using
InTouch as something
other than an address
book.

Low Either provide or allow the
user to plug in a spell-
checker.

User wants to use a
different font, e.g. bold,
for portions of the record
text.

Functionality: missing
functionality (35.1).

Capability would allow
delineating things with
fonts; it is very desirable
when you're using
InTouch for something
other than an address
book.

Low Add support for different
fonts to InTouch.

Find

Problem Error Classification /
Discussion

Importance Potential
Solution

User has trouble finding
“Find” in the menubar.

Menu organization:
inappropriately grouping
unrelated choices in a
menu (19.9). By
convention, find is
usually found in the Edit
menu.

High Move find to a location
more intuitive to Mac users,
i.e. the Edit menu.

User can’t find a record
that is in the file because
he doesn’t realize that find
only searches the current
group.

Error message does not
help user solve problem
(27.4).

User did not understand
the interaction (32.3)

High 1. Make group an explicit
part of the find dialog,
default current group.

2. In error message,
explicitly state the
parameters find used.
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User doesn't understand
field option on find.

User does not
differentiate the fields in
the main window; did not
under stand interaction
(32.3)

Medium Label the fields on the main
window.

User doesn’t realize that
the record wasn’t found
because he had the whole
word only option on.

Error message does not
help user solve problem
(27.4).

Medium Need to be more specific in
find error messages, in
particular what options
guided the search.

“Find” dialog box does not
contain a cancel button.

Direct Manipulation:
missing direct
manipulation (29.2).
User can close dialog
box (and thereby
canceling request) but
cannot directly cancel
request

Low Add “Cancel” button to
“Find” dialog box.

Insert

Problem Error Classification /
Discussion

Importance Potential
Solution

After typing a new record,
the subject hits insert
which brings up another
new record. (Occurred
frequently with novice
users.)

26.2 Missing feedback.
Unaware operation is
complete.

High Add feedback...not
message, just have the text
appear in the records list as
user is typing so they can
see that the record has
already been inserted.
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Snapshot

Problem Error Classification /
Discussion

Importance Potential
Solution

User repeatedly clicks the
snapshot button in the
main window trying to
figure out what it does.
When multiple clicks
appear to do nothing, user
is mystified.

Name/label: label not
meaningful to user
(24.7); non-
message/message
feedback is needed
(23.2/26.2).

Also, user did not
understand the
interaction (32.3).

High 1. Change label/icon to a
more meaningful term, e.g.
clipboard, or

2. Clipboard is just a form
of cut and paste. Consider
treating it as such: place
additional commands under
edit, i.e. show clipboard and
eliminate snapshot button.
At the same time, improve
overall cut and paste
operations on records,
groups, etc.

When user hit snapshot,
the word snapshot
appears in the clipboard,
not the address field.
(Word 6.0 running at
time.)

Functionality not
implemented correctly
(35.2).

High Fix so functionality matches
documentation.

User wants to use cut and
paste on entire records
without resorting to
“Snapshot” dialog.

Direct Manipulation:
missing direct
manipulation (29.2).

Medium Allow users to highlight
multiple records in record
list, and then cut and paste.

If a user highlights items in
the record list, the operation
applies to the entire record;
if highlight items in other
fields, operation only
applies to object being
manipulated in that field.
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Sort

Problem Error Classification /
Discussion

Importance Potential
Solution

User assumes when he
sorted the ALL group, all
records in all groups are
sorted.

Did not understand the
interaction (32.3)

Feedback message
general rather than
specific (26.5)

Medium Feedback message should
make it clear that only one
group, All, was sorted.

User confused that sort
dialog box changed since
last use.

Each group has it’s own
sort order. Not
apparent to user. (32.3)

Low Document, preferably on-
line.

User wants to cancel sort,
but unsure if done will
cancel without doing sort.

Missing button (20.2) Low Add Cancel button.

User would like to be able
to sort several groups
simultaneously.

User can sort multiple
groups by selecting sort
repeatedly, but cannot
sort multiple groups in
one step. (32.9)

Low Modify selection method to
allow multiple groups to be
selected.

Reminders

Problem Error Classification /
Discussion

Importance Potential
Solution

User locates calendar by
trial and error.

Label not meaningful
(24.7); user's don't
understand what the
remind corresponds to.
Also, icon is not
meaningful (20.9) to
user.

High Change reminder label to a
term more meaningful to
users. During testing, users
generally referred to the
item as a calendar or alarm.
Change icon accordingly.

User sidetracked by
Dateview button and
highly annoyed when it
points to a product that is
not installed. Views
button as an
advertisement and
annoyance.

Misleading visual cue
(30.7). Dateview Button
is largest, most salient
on screen but
functionality not
supported.

Also, system did not
make erroneous choices
unavailable (39.4).

High In preferences, allow user
to specify whether the
Remind button takes the
user to the standard
calendar or DATEVIEW.
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Novice user has great
difficulty determining
where to enter new
appointment. Focuses on
the calendar and doesn’t
see the new button.

Related features not well
grouped (19.6)

Medium Try putting buttons to
manipulate calendar closer
to the calendar. De-clutter
screen as much as
possible.

“View” in “Remind” dialog
box has no meaning for
many users.

Label not meaningful
enough.

User did not understand
interaction (32.4)

Medium Try more descriptive label,
e.g. view reminders.

User confused by
disabling of modify /
delete buttons on a day
she defined a reminder.

Need to have an event
highlighted for the
buttons to be enabled.
User did not understand
interaction (32.4)

Medium Possibly use the first event
of the day as the default.

New

Problem Error Classification /
Discussion

Importance Potential
Solution

Subject misses the for
part of the calendar
repeat. Does multiple
instances of the reminder
by hand.

Related features not well
grouped (19.6)

Medium Screen is very busy. Needs
a better organization.

User does not understand
the repeat for still; does it
with special. Proximity of
the two not clear; or
wording problem.

Interaction too complex:
32.2.

Related features not well
grouped (19.6)

Medium Special is not particularly
meaningful to users. May
want new label or simplify
underlying interaction.

User not sure that
reminder was created.
Goes to calendar to
check.

Missing feedback. Low Add feedback.
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Modify

Problem Error Classification /
Discussion

Importance Potential
Solution

Changing a single
reminder that was
generated by repeating
another reminder crashes
InTouch and sometimes
the user’s computer.

Functionality
implemented incorrectly
(35.2).

High Fix bug.

Special

Problem Error Classification /
Discussion

Importance Potential
Solution

User has no clue as to
what L stands for in
special dialog box.

Label not meaningful
enough.

User did not understand
interaction (32.4)

High Use a descriptive label.

When in event dialog box,
the special by day yields
boxes numbered from 1
to 31, user doesn't know
which day of the week
goes with which day.

Missing label (24.2) Medium Label days of the week.
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APPENDICES

Appendix A: Test Plan
The following is the test plan for conducting usability tests of version 2.5.2 of the free-
form information manager InTouch.7 The plan contains the following sections:

 Purpose

 Test Objectives

 User Profile

 Method

 Task List

 Test Environment / Equipment

 Evaluation Measures

 Test Report Contents and Presentation.

Purpose

The main purpose of this test is to asses the performance of an actual customer with
little or no previous InTouch experience. The usability test will measure the total time
needed to accomplish information entry and output, and record observed critical
incidents. Tasks will include routine operations, print operations, and import/export of
data.8 Particular attention will be paid to those features that have been the target of
significant negative customer feedback.9

Test Objectives

Specifically, the test will determine if an actual customer with little or no previous
InTouch experience can

 Successfully enter information into InTouch within the first 5-10 minutes of use.10

 Successfully output information from InTouch within the first half hour of use. 11

 Successfully perform routine tasks associated with sorting, grouping, and retrieving
of information.

 Successfully use print and import / output dialogs.

The Prairie Group has received numerous complaints about the printing and import /
export dialogs. The test will attempt to determine the precise nature (and possibly the

7 InTouch is a product of the Prairie Group, P.O. Box 65820, West Des Moines, Iowa 50265.
8 Originally, installation was included in the task list. However, as the installation process is straightforward

but time-consuming, it was not included in the final task list.
9 Prairie Group developers summarized and relayed customer complaints to usability testers.
10 5-10 minutes is Prairie Group development goal.
11 First half hour is Prairie Group development goal.
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source) of customer difficulties -- potentially leading to recommendations for redesign of
the problem area.
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User Profile

A total of 5 participants will be tested. A total of 6 people will be selected (5 participants
and 1 alternates) that satisfy the following requirements:

Characteristic Range Frequency Distribution
Macintosh Experience Some n / a.
InTouch Experience None. 100%12

Computer Experience Novice, Intermediate n / a.

Method

The test will consist of

1. A performance test of benchmark tasks plus some representative tasks designed to
gather InTouch usability information through remote evaluation.

2. A user preference questionnaire designed to determine how successful InTouch was
at satisfying user expectations of a free-form information manager.

It will consist of the following three stages:

1. General Introduction:

 Participant will be given a short, scripted introduction to the test which explains
the purpose and objectives of the test.

 Participant will be introduced to the testing environment.

 Participant will be verbally informed that the test session will be observed and
videotaped. At this time, the participant will be asked to read and sign the
consent form.

 Participant will be given the pre-test instructions.

 Participant will be given detailed information on how tasks will be presented and
what is expected of the participant; participant will be given a short demo of
thinking aloud.

 Participant will be given final verbal reminders. In particular, he / she will be
reminded that

a. The test evaluates the quality of InTouch, not the performance of the
participant.

b. He / she should refer to the manual only if he / she gets stuck and is unable
to complete the task.

2.

12 Originally, participants with some InTouch experience were to be tested. However, no one with InTouch
experience could be recruited.
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Performance Test:
The performance test will consist of a series of benchmark and representative tasks
that the participants will be asked to perform. The test will be videotaped. The basic
procedure for the test will be

 After the introduction is completed, the participant will escorted to the evaluation
room and will sit down at the desk (see description of test environment).

 The participant will be guided through a series of tasks by the tester. The
participant will be encouraged to

a. Work without input from the tester.

b. Think aloud while working through the task.

c. To refer to the manual only when stuck.

3. Post-test debriefing:
After all tasks are completed, the participant will be given a short break. After which,
the participant will fill out a brief user preference questionnaire about the functionality
and usability of InTouch. Finally, the participant will be given the opportunity to ask
questions or make comments about InTouch and the testing process.

Following completion of the test, the participant will be thanked and dismissed.

Task List

 Starting up InTouch.

 Inserting records into an InTouch file.

 Finding records meeting certain criteria.

 Deleting records meeting certain criteria.

 Adding and deleting reminders, including repeated reminders.

 Printing a fax cover sheet.13

 Exporting information from InTouch.

 Importing information from InTouch.

 Saving an InTouch file under a different name.

Test Environment / Equipment

The test will be conducted in the Virginia Tech Computer Science Usability Laboratory.
During the performance test, the participant will sit at a desk in the evaluation room with
the door closed. If a member of the test team is available, he / she will remain in the
evaluation room with the participant. On the desk will reside a Macintosh computer.
Close to the desk on a side table will be the following items.

1. A printer.

 Should not be an HP printer.14

13 Originally, participants were to use InTouch to print out envelopes. However, during this operation during
pre-test, subjects had great difficulty manipulating the printer. Print out of fax covers was substituted as it
required no manipulation of the printer.
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 Should already be stocked with paper.

 Should be correctly connected to the Mac.

2. An InTouch User’s Manual.

3. InTouch will be running on the Mac with the

 The test InTouch file open.

 The InTouch reminder list clear.

Evaluation Measures

The following evaluation measures will be collected and calculated.

1. Observations and comments for each critical incident.

2. Classification of errors associated with critical incidents: severity, scope, and source
of error will be indicated whenever possible.

3. The time necessary to complete each benchmark task.

4. The percentage of participants who successfully complete each task.15

5. Participant rankings of the functionality and usability of InTouch.

Test Report Contents and Presentation

The report will include the following sections:

1. Executive Summary.

2. Description of the Test.

3. Results which contains a summary of all results in tabular form.

4. Findings, Explanations, and Recommendations.

5. Appendices containing.

 Task scenarios.

 The test plan.

 The post-test questionnaire.

 Raw data from the test.

The target audience for this report will be the Prairie Group developers.

14 The InTouch HP print drivers are known to be buggy. Prairie Group is working on the problem so there is
no reason to subject a participant to the problems.

15 A task is classified as successful or unsuccessful. No partial measures of completion will be used.
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Appendix B: Task Scenarios

1. The file that you see is your family rolodex. Put your
name and work phone number in the rolodex so other family
members can contact you in an emergency. (Benchmark task: Insert a
Record.)

2. Save a copy of your family rolodex for personal use. Call
the copy “MY ROLODEX”. You will work with “MY
ROLODEX” for the remainder of this session. (Benchmark task: Save a
File Under a Different Name.)

3. Play around with the system, exploring anything you like
in the InTouch System, for as long as you like.

4. Ken Landry is already entered in your rolodex. He just
called you with his new home phone number, add it to his
entry. Ken’s home phone number is 500-1234. (Benchmark task: Find a
Specific Record.)

5. You decide you don't want all of Mary's friends in your
rolodex. Make a list of Mary’s friends. Delete Sallie’s and
Brian’s information. (Benchmark task: Delete Records Belonging to a Group.)

6. Order the entries in your rolodex alphabetically so that
people with the same last name appear together, with family
members listed alphabetically by first name. (Benchmark task: Sort a
File.)
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7. Congratulations, you just found a new ballroom dance
class. It meets every Wednesday 8:00-10:00 PM for the next 3
months. Add the class to your calendar. (Benchmark task: Add a Reminder.)

8. You notice that all your relatives have “RELATIVE” in the
notes field. You decide to make “family” a new group, and
make all your relatives members of the group. (Benchmark task: Make
a New Group.)

9. You decide to print out a fax cover sheet for David A.
Groom. Be sure to include your return address on the cover
sheet. (Benchmark task: Print a Fax Cover.)

10. Uncle Harry (a new InTouch user) would like you to
send him an file containing the names and addresses of all
the relatives your family sends Christmas cards to. Create an
InTouch file by the name of "Relatives" to send to Uncle
Harry. (Benchmark task: Export Records Belonging to a Specific Group.)

11. You have to go to Washington, D.C. for the weekend.
You don’t want to stay in a hotel. You want to stay with
someone you know. How many people do you know in
Washington? (Benchmark task: Find Records Using a Simple Group Search.)

12. After thinking more about the weekend, you decide you
want to stay with family. Find a relative in Washington.
(Benchmark task: Find Records Using a Complex Group Search.)
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13. You're in charge of organizing soccer this year. Last
year's organizer gave you a tab-delimited text file (“Soccer
People”) containing the names and addresses of the relevant
people. Add this people to your rolodex -- put them in the
Soccer group for easy reference. (Benchmark task: Import Data From a File.)

14. That’s enough work for today. Shutdown InTouch.

15. Wait you forgot something, re-open “My Rolodex”.
(Benchmark task: Close then ReOpen InTouch.)
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Appendix C: Post-test Questionnaire16

Directions:

Please rate each of the items according to the scales provided and circle the
appropriate number.

A. Overall Reactions to InTouch

1)
0 1 2 3 4 5 6 7 8 9

terrible wonderful

2)
0 1 2 3 4 5 6 7 8 9

difficult easy

3)
0 1 2 3 4 5 6 7 8 9
dull stimulating

4)
0 1 2 3 4 5 6 7 8 9

inadequate power adequate power

5)
0 1 2 3 4 5 6 7 8 9

rigid flexible

B. Screen

1) Organization of information on screen

0 1 2 3 4 5 6 7 8 9
confusing very clear

16 Adaptation of the QUIS (Questionnaire for User Interface Satisfaction) rating scale developed by the
University of Maryland.
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2) Sequence of screens

0 1 2 3 4 5 6 7 8 9
confusing very clear

3) Characters on the computer screen

0 1 2 3 4 5 6 7 8 9
hard to read easy to read

4) Highlighting on the screen simplifies task

0 1 2 3 4 5 6 7 8 9
not at all very much

C. Terminology and System Information

1) Use of terms throughout system

0 1 2 3 4 5 6 7 8 9
inconsistent consistent

2) Computer terminology is related to the task you are doing

0 1 2 3 4 5 6 7 8 9
never always

3) Messages on screen which prompt user for input

0 1 2 3 4 5 6 7 8 9
confusing clear

4) Computer keeps you informed about what it is doing

0 1 2 3 4 5 6 7 8 9
never always

5) Error messages

0 1 2 3 4 5 6 7 8 9
unhelpful helpful
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D. Learning

1) Learning to operate the system

0 1 2 3 4 5 6 7 8 9
difficult easy

2) Exploring new features by trial and error

0 1 2 3 4 5 6 7 8 9
difficult easy

3) Tasks can be performed in a straight-forward manner

0 1 2 3 4 5 6 7 8 9
never always

4) Remembering names and use of commands

0 1 2 3 4 5 6 7 8 9
difficult easy

5) Help messages on the screen

0 1 2 3 4 5 6 7 8 9
unhelpful helpful

6) Supplemental reference materials

0 1 2 3 4 5 6 7 8 9
confusing clear

E. System Capabilities

1) Correcting your mistakes

0 1 2 3 4 5 6 7 8 9
difficult easy

2) Experienced and inexperienced users' needs are taken into consideration

0 1 2 3 4 5 6 7 8 9
never always
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3) As a free-form information manager, InTouch is

0 1 2 3 4 5 6 7 8 9
useless useful

4) When compared to other information managers you have used, InTouch is

0 1 2 3 4 5 6 7 8 9
difficult easy
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Appendix D: Raw Test Data

Performance Data

Positive Critical Incident Data

Subject

Task 1 2 3 4 5 Mean

Insert a Record 0 0 0 0 0 0

Save a File Under a Different Name 0 0 0 0 0 0

Find a Specific Record 0 0 1 0 0 0.2

Delete Records Belonging to a Group 0 0 0 0 0 0

Sort a File 0 0 0 0 0 0

Add a Reminder 0 0 0 0 0 0

Make a New Group 0 0 0 0 1 0.2

Print a Fax Cover 0 0 0 0 0 0

Export Records Belonging to a Group 0 0 0 0 0 0

Find Records Using a Simple Group Search 0 0 0 0 0 0

Find Records Using a Complex Group Search 0 0 0 0 0 0

Import Data From a File 1 0 2 0 0 0.6

Close then ReOpen InTouch 0 0 0 0 0 0

Negative Critical Incident Data

Subject

Task 1 2 3 4 5 Mean

Insert a Record 1 0 3 4 0 1.6

Save a File Under a Different Name 2 2 7 2 1 2.8

Find a Specific Record 4 5 0 6 0 3

Delete Records Belonging to a Group 3 4 1 3 1 2.4

Sort a File 3 0 1 2 0 1.2

Add a Reminder 3 9 3 10 0 5

Make a New Group 2 6 6 3 0 3.4

Print a Fax Cover 5 5 4 4 1 3.8

Export Records Belonging to a Group 1 2 1 1 2 1.4

Find Records Using a Simple Group Search 0 2 2 3 2 1.8

Find Records Using a Complex Group Search 0 5 2 0 0 1.4

Import Data From a File 4 1 1 3 5 2.8

Close then ReOpen InTouch 1 2 1 1 1 1.2

Task Completion Data

Subject %
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Task 1 2 3 4 5 Completed

Insert a Record ✔  ✔  ✔  ✔  ✔  100

Save a File Under a Different Name ✔ ✔  ✔  ✔  ✔  100

Find a Specific Record ✔  ✔   ✔  60

Delete Records Belonging to a Group ✔ ✔  ✔   ✔  80

Sort a File ✔ ✔  ✔  ✔  ✔  100

Add a Reminder ✔ ✔  ✔  ✔  ✔  100

Make a New Group ✔  ✔   ✔  60

Print a Fax Cover ✔ ✔  ✔   ✔  80

Export Records Belonging to a Group ✔ ✔    ✔  60

Find Records Using a Simple Group Search ✔   ✔  ✔  60

Find Records Using a Complex Group Search ✔  ✔  ✔  ✔  80

Import Data From a File  ✔  ✔  ✔  60

Close then ReOpen InTouch ✔  ✔   ✔  60

Percentage of Tasks Successfully Completed by Subject 76.9 69.2 84.6 53.8 100

Task Timing Data

Subject Mean

Task 1 2 3 4 5 Time (sec)

Insert a Record 43 202 286 192 81 160.8

Save a File Under a Different Name 133 101 259 82 44 123.8

Find a Specific Record 198 312 26 519 48 220.6

Delete Records Belonging to a Group 261 99 115 58 138 134.2

Sort a File 293 102 247 435 94 234.2

Add a Reminder 506 703 139 666 95 421.8

Make a New Group 297 345 508 472 110 346.4

Print a Fax Cover 269 472 335 630 106 362.4

Export Records Belonging to a Group 187 273 167 57 334 203.6

Find Records Using a Simple Group Search 145 178 132 253 222 186

Find Records Using a Complex Group Search 66 101 124 38 50 75.8

Import Data From a File 330 378 167 481 337 338.6

Close then ReOpen InTouch 10 45 112 17 90 54.8

Post-Test Questionnaire

Subject

1 2 3 4 5 Mean

Overall Reactions to InTouch (Average Rating) 3.6 4.2 3.8 3.2 7.2 4.4

terrible ... wonderful 3 6 2 4 7 4.4

difficult ... easy 3 3 1 4 8 3.8
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dull ... stimulating 3 4 4 0 6 3.4

inadequate power ... adequate power 6 3 8 4 8 5.8

rigid ... flexible 3 5 4 4 7 4.6

Screen (Average Rating) 4.5 2.75 3.25 3.5 8 4.4

Organization of information on screen 3 1 2 2 7 3

Sequence of screens 6 1 3 2 9 4.2

Characters on computer screen 6 1 6 9 9 6.2

Highlighting on screen simplifies task 3 8 2 1 7 4.2

Terminology and System Information
(Average Rating)

2.6 3.6 2.6 2.4 7.6 3.76

Use of terms throughout system 3 8 1 4 6 4.4

Computer terminology is related to the task 4 3 5 2 7 4.2

Messages on screen which prompt user for input 1 3 1 2 9 3.2

Computer keeps you informed about what it is doing 2 2 5 4 8 4.2

Error messages 3 2 1 0 8 2.8

Learning (Average Rating) 4 3.2 2.7 0.7 7.3 3.6

Learning to operate the system 3 2 1 0 8 2.8

Exploring new features by trial and error 5 7 2 1 9 4.8

Tasks can be performed in a straight-forward manner 3 3 2 1 7 3.2

Remembering names and use of commands 3 3 2 1 8 3.4

Help messages on the screen 4 0 2 0 7 2.6

Supplemental reference materials 6 4 7 1 5 4.6

System Capabilities (Average Rating) 3 4.5 1.5 1.5 8.25 3.75

Correcting your mistakes 6 9 2 1 9 5.4

Experienced and inexperienced users’ needs are taken into
consideration

2 1 1 1 9 2.8

As a free-form information manager, InTouch is 3 7 2 2 8 4.4

When compared to other information managers you have
used, InTouch is

1 1 1 2 7 2.4


